
Adobe Audition CC
Detailed Video Training Outline

Chapter 1 - Overview
01.01	

 Welcome

• An overview of this entire training

01.02	

 What This Training Covers
• What this training covers
• How to use this training
• A list of all chapters

01.03	

 New Features in the CC Release
• A list of key new features

01.04	

 Audio Definitions
• Define key terms 
• Explain key audio concepts
• Build the foundation for this training series

Chapter 2 - Learning the Interface
02.01	

 Chapter Introduction

• An overview of the material covered in this chapter

02.02	

 Workspaces and Customization
• Define panels and workspaces
• How to change workspaces
• Create a new workspace
• Display all panels and add to a workspace
• Access existing panels
• Resize, move, and hide panels
• Delete unneeded workspaces
• Reset a workspace back to its default setting

02.03	

 Navigation and Zooming
• Navigate within the Waveform Editor
• Navigate within the Multitrack View

02.04	

 Multitrack View
• Learn how to use the fly-out panel menus
• Move the playhead inside the Timeline
• Find and use track header features
• Change track and clip colors
• Customize the audio meters
• Understand all the numbers in the lower right corner

02.05	

 Waveform Editor
• Display a clip in the Waveform Editor
• Move between the Waveform Editor and Multitrack Editor
• Scroll inside the Waveform Editor
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• Display waveform, frequency and pitch data
• Toggle the new Preview editor on or off
• Change the dB display
• Toggle individual channels on or off

02.06	

 Reviewing and Setting Preferences
• Open and modify preference settings
• Discover preferences that are new with this release
• Optimize your system by changing key preference settings

02.07	

 Customizing Keyboard Shortcuts
• Optimize your editing by finding, creating, and modifying keyboard shortcuts.

02.08	

 Keyboard Shortcuts for this Chapter
• A table listing relevant keyboard shortcuts for material covered in this chapter

Chapter 3 - Recording Audio 
03.01	

 Chapter Introduction

• An overview of the material covered in this chapter

03.02	

 Recording Overview 
• Configure audio hardware preference settings
• Create a new Multitrack session
• Arm tracks and enable recording
• Set the audio input and enable monitoring
• Record to a new track
• Stop recording and listen to the playback

03.03	

 Recording Inside an Existing Session 
• Add a new recording section to an existing track
• Add a new track in the Multitrack View
• Configure a track for recording
• Move tracks up or down in the Multitrack Editor
• Record to a selection

03.04	

 Using Templates
• Define Multitrack templates
• Select a template
• Save a custom template
• Show where templates are stored 
• Show how to delete a template

03.05	

 Keyboard Shortcuts for this Chapter
• A table listing relevant keyboard shortcuts for material covered in this chapter

Chapter 4 - Importing Files
04.01	

 Chapter Introduction

• An overview of the material covered in this chapter
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04.02	

 Overview - Media Browser
• Use the Media Browser to locate a clip on your hard disk
• Import a file using the Media Browser
• Show how to use the Auto-play button
• Show how to create a location shortcut
• Show how to use the contextual menu to import clips

04.03	

 Other Ways to Import 
• Import a file using the File menu
• Import a file using the Files panel
• Import a file using keyboard shortcuts
• Import a file by dragging from the Finder

04.04	

 Import Projects
• Send a sequence from Premiere Pro CC to Audition CC
• Open an OMF file to load a project from another editor
• Open an XML files to load a project from another editor

04.05 Import a Video Clip
• Import a video clip using the File menu, Files pane, or Media Browser
• How to place a video clip in the Timeline
• How to move a video clip in the Timeline

04.06	

 Relinking Missing Media
• Relink missing media using the Link Media command

04.07	

 Keyboard Shortcuts for this Chapter
• A table listing relevant keyboard shortcuts for material covered in this chapter

Chapter 5 - Waveform Editing
05.01	

 Chapter Introduction

• An overview of the material covered in this chapter

05.02	

 Overview
• Load a clip into the Waveform Editor
• Disable individual audio channels
• Create separate files for each audio channel
• Select and trim regions
• Use the HUD to make audio gain adjustments
• Add fades to the beginning and ending of a clip
• Save changes with the clip

05.03	

 Markers and Ranges
• Create and movie a marker
• Navigate between markers
• Rename a marker
• Convert a marker into a range
• Use the Marker panel to adjust markers
• Move a selected range into a Multitrack edit
• Display all the markers in a project
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05.04	

 Playlists
• Create, modify and play a playlist
• Export a marker range as a separate audio file

05.05	

 Keyboard Shortcuts for this Chapter
• A table listing relevant keyboard shortcuts for material covered in this chapter

Chapter 6 - Multitrack Editing
06.01	

 Chapter Introduction

• An overview of the material covered in this chapter

06.02	

 Overview
• Edit a clip from the Files panel into the Timeline
• Select, move, and delete a clip
• Trim the edges of a clip
• Select a range within a clip, then delete it
• Add a fade to the end of a clip
• Locate the source of a Timeline clip in the Files panel
• Use the History panel to track changes during editing

06.03	

 Move, Position, and Merge Clips
• Move a clip manually
• Move a clip using the Properties panel
• Overlap clips
• Change the stacking order of overlapped clips
• Determine how over-lapped clips play in a stack by changing preference settings
• Merge two or more clips to create a new clip

06.04	

 Trim Clips
• Trim (adjust) the In and Out of a Clip
• Select a range within a clip, or between clips
• Delete a range within or between clips
• Use Skip Selection to preview an edit
• Select and use the Skip tool
• Use keyboard shortcuts to trim a clip

06.05	

 Add Fades and Change Fade Shapes
• Add a fade to a clip
• Add a fade between two clips
• Change the fade shape for a single clip
• Change the fade shape between two clips
• Modify preferences to change the default fade shape

06.06	

 Other Clip Settings
• Rename a clip
• Loop a short clip to extend the audio
• Copy a clip
• Create a group, then ungroup clips
• Reposition and trim a group
• Add a fade to a group
• Examine the properties of a clip
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06.07	

 Markers, Subclips, and the Markers Panel
• Add a marker
• Change a marker type
• Rename a marker
• Move or remove a marker
• Jump the playhead to a marker location
• Use the Markers panel
• Display all markers in all open sessions or clips

06.08	

 Split a Multi-channel Audio Clip
• Split a multi-channel audio clip into separate mono channels for editing

06.09	

 Automatic Speech Alignment
• Align to audio clips and get the dialog timing to match between them

06.10	

 An Audio Editing Example
• This is an illustration of how I would edit a simple interview in the Multitrack 

View, using the tools discussed in this chapter.

06.11	

 Keyboard Shortcuts for this Chapter
• A table listing relevant keyboard shortcuts for material covered in this chapter

Chapter 7 - Working with Video
07.01	

 Chapter Introduction

• Provide an overview of the material covered in this chapter

07.02	

 Overview
• Send a project from Premiere Pro CC to Audition CC
• Send a completed mix from Audition back to Premiere Pro

07.03	

 Maintain Sync Between Clips
• Import a video clip
• Edit the video clip to the Timeline
• Change the workspace to display the video clip
• Lock the audio to the video so it remains in sync using “Lock in Time”
• Group audio clips with the video clip to maintain sync

07.04	

 Send Projects From Premiere Pro CS6
• Export audio files from Premiere Pro CS6 using OMF
• Export a video file from Premiere
• After the mix is complete, export the mix for import back into Premiere Pro

07.05	

 Sending Files From Final Cut Pro 7 (or earlier versions)
• Export files from Final Cut Pro 7 to Audition using XML
• Export files from Final Cut Pro 7 to Audition using OMF
• Export a video mix from Final Cut
• Export the final audio mix from Audition for import back into FCP

07.06	

 Exporting Files From Final Cut Pro X
• Export an XML file from Final Cut Pro X to Audition
• Export a video mix from Final Cut Pro X
• Convert the XML file for import into Audition
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• Import both the XML and video files into Audition
• Export the final audio mix for import back into Final Cut

07.07	

 Keyboard Shortcuts for this Chapter
• A table listing relevant keyboard shortcuts for material covered in this chapter

Chapter 8 - Repairing Audio in the Waveform Editor
08.01	

 Introduction

• Provide an overview of the material covered in this chapter

08.02	

 Edit Plosives, Adding Silence
• Open a clip in the Waveform Editor
• Remove an exploded “P”
• Add silence to maintain video sync
• Save the file to retain changes, without losing the original file

08.03	

 Remove Hum
• Remove hum from a clip
• Adjust harmonics to improve voice quality

08.04	

 Repair Clips Sent From Premiere Pro CC
• Send a clip from Premiere Pro CC to Audition CC
• Repair it
• Send it back from Audition to Premiere Pro

08.05	

 Reduce Noise
• Learn which tools don’t work well
• Capture a noise print
• Reduce noise
• Adjust the amount of reduction

08.06	

 Sound Remover
• The new feature removes sounds which vary in frequency
• Reduce, or remove sounds which vary in frequency

08.07	

 Repair Clipped Levels
• Clipped levels are often caused by bad AGC circuits or poor recording
• Fix an audio clip containing clipped levels

08.08	

 Remove Clicks and Pops
• Use the Automatic Click Remover effect to decrease clicks
• Use the Declicker diagnostic tool to decrease clicks and pops
• Edit a click manually

08.09	

 Clean-up frequencies
• Display the spectral view
• Select a range of frequencies and remove them
• Paint over an offending sound and reduce it without destroying other audio
• Reduce the same sound using Sound Remover

08.10	

 Keyboard Shortcuts for this Chapter
• A table listing relevant keyboard shortcuts for material covered in this chapter
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Chapter 9 - Levels and Mixing
09.01	

 Introduction

• Provide an overview of the material covered in this chapter

09.02	

 Overview of Setting Levels
• Where to set audio levels and pan
• Customize the audio meters
• Set audio levels for a track
• Set audio levels for a clip
• Set pan the a track
• Set pan for a clip
• Use the Clip Gain feature in the Properties panel
• Show how to override snapping when adjusting levels

09.03	

 Envelopes, Keyframes, and Automation
• Create, modify, move and delete keyframes with the mouse
• Create keyframes using automation
• Once keyframes are created, you use the mouse to change them
• Convert an envelop from linear to splines

09.04	

 A Mixing Example
• Watch over my shoulder as I create a project mix for a fairly simple project

09.05	

 The ITU Loudness Radar
• Apply the ITU Loudness Radar to the master track output
• View the results of the ITU Loudness Radar and understand what to watch for

09.06	

 Using Match Volume
• Match Volumes between clips in the Timeline
• Use the Match Volume panel for batch processing

09.07	

 Introduction to the Mixer
• Display the mixer in Audition
• Understand the controls in a channel strip
• Learn how all the channel strips flow into the Master output

09.08	

 Sends and Busses
• Create a Bus
• Create a Send
• Create a sound effects submix
• Create a reverb effect using a bus

09.09	

 Analyze Amplitude
• Automatically analyze a clip for loudness, using several different criteria
• Provide a general explanation of key measurements to review

09.10	

 Analyze Frequencies
• Display the Frequency Analysis window
• Isolate the range of a clip to review to focus on specific frequencies

09.11	

 Keyboard Shortcuts for this Chapter
• A table listing relevant keyboard shortcuts for material covered in this chapter
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Chapter 10 - Effects
10.01	

 Chapter Introduction

• Provide an overview of the material covered in this chapter

10.02	

 An Overview of Effects
• Display effects in the Effects menu
• Organize effects in the Effects Rack
• Add, modify, disable, reset, and remove an effect
• Pre-render an effect
• Show how to access effects from the Multitrack Timeline

10.03	

 Level (Dynamic) Effects
• Apply and modify the Multiband Compressor
• Apply and modify the Hard Limiter
• Why using the Speech Volume Leveler is a bad idea

10.04	

 EQ Effects
• Analyze frequencies using the Frequency Analysis window
• Find, apply, and modify the Parametric EQ filter

10.05	

 Time-Stretch and Speed Effects
• Change the duration and pitch of a clip

10.06	

 Reverb Effects
• Find and apply a reverb effect
• Adjust the effect to find the right room size and the correct amount of the 

effect for your talent

10.07	

 Real-time Repair
• Remove hum
• Remove/reduce clicks
• Reduce noise

10.08	

 Using Effects Presets
• Review existing presets
• Apply an existing preset to a track
• Create a new preset
• Delete a preset
• Access Favorites
• Record, playback, and delete a Favorite

10.09	

 Tones and Metronome
• Create a metronome beat.
• Generate a variety of useful, and not so useful, tones

10.10	

 Keyboard Shortcuts for this Chapter
• A table listing relevant keyboard shortcuts for material covered in this chapter

Chapter 11 - Saving and Exporting
11.01	

 Introduction

• Provide an overview of the material covered in this chapter
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11.02	

 Overview
• Show how to save a single file
• Send a file between Premiere Pro CC and Audition CC
• Send a completed mix from Audition to Premiere Pro CS6
• Export a completed mix as a stand-alone WAV file
• Analyze a completed mix to make sure it meets technical specs

11.03	

 Ranges and Stems
• Export a range from a mix
• Export stems (submixes)

11.04	

 Batch Processing and Export
• Open the Batch Process window
• Load files into it
• Create a Favorite 
• Apply a Favorite to a batch
• Modify export settings
• Select between exporting files or loading them into the Files panel

11.05	

 Keyboard Shortcuts for this Chapter
• A table listing relevant keyboard shortcuts for material covered in this chapter

Chapter 12 - Closing
12.01	

 It’s a Wrap!

• Concluding thoughts for this training
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